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Equipment List 
Motion detector 
Force probe 
Level 
211 friction cart with reflector 
211 magnet cart without reflector 
Standard cart track setup 
Meter stick 
Rod and clamp setup to hold force probe 
Double pulley setup 
Standard red extension spring 
String loop for holding spring at the top of the incline 
Masses 
 50 gram (1) 
 100 gram (3) 
50 gram mass hanger 
String with loops an each end 
Chain 
Meter stick 
 
 
Computer File List 
MacMotion file “211-02 Force Score and Seven...” 
MacMotion file “211-02 Force/Accel 1” 
MacMotion file “211-02 Force/Accel 2” 
MacMotion file “211-02  Spring” 
MacMotion file “211-02  Spring.CLB” 
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Investigation 1:  Weight and Mass  
  
Goals:  • To find out how to use a force probe to measure forces 
  • To study the characteristics of weight  

Activity 1:  May the Force Probe Be With You 
Introduction: The force probe you will use in this and later laboratories measures the amount 

of force applied to the probe.  It is not critical that you understand precisely how 
the force probe works...ok, if you must know, the force probe uses strain gauge 
technology.  When you push or pull on the probe’s hook, a beam inside is bent 
one way or the other.  Two strain gauges attached to each end of the beam are 
strained less or more by this bending.  The change in strain causes a change in 
the electrical resistance of the gauges, which in turn results in a change in a 
voltage within the force probe’s electronics.  This voltage change is proportional 
to the change in force.  MacMotion translates this voltage change into Newtons 
and can define zero force points.  The switch on the sensor allows you to select 
either of two ranges of force measurement:  +/- 10N or +/- 50N.  In the 211 labs, 
you will always use the 10N range. 

Procedure: 1. Open the MacMotion program.  Double click on the MacMotion icon. Set up 
to graph force. 

 •  Open... (under the File menu) the file FORCE SCORE AND SEVEN...  in 
the Lab 2 folder.  A graph like that shown in Figure 1 should appear on 
the screen: 

    
Figure 1.  Force Score graph format for Activity 1 

  
 2. Set up the force probe.  Clamp the force probe to a support with its hook 

 pointing vertically downward as in Figure 2.  The probe should be plugged 
 into DIN 1 of the Laboratory Interface Box (flat gray box). 
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   mass 
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force probe “hook”

 

    Figure 2.  Experimental setup for Activity 1 

 

Procedure: 3. “Zero" the force probe.  With nothing hanging on the force probe, zero the 
(continued)   probe by selecting Zero Force from the Collect menu, or by clicking on 

 the Zero button at the bottom of the screen.  This will take a few seconds. 

 *Note - In this activity, "zeroing" the force probe assures that zero will be 
displayed on the screen when no force is applied by (or on) the probe.  Any 
small mechanical change in the force probe--including changing its orientation--
will change the zero setting.  Therefore, zero the probe frequently in the 
orientation in which it will be used just before taking measurements. 

 4. Get a feel for the force probe by plotting a force vs. time graph. 
 • With the hook of the force probe pointing vertically downward, click on 

Start to graph force.  Note what the graph looks like while alternately 
pushing up and pulling down on the hook gently. 

 

Question: •Does the force probe record a push as a positive force or as a negative force?  
What about a pull? 

 ___________________________________________________________ 
 
 
  



 

© University of Illinois  Physics 211 - Lab 2  Page 3 of 17  

Procedure: 5.  Prepare to measure the weights of different hanging masses.  Rescale the 
(continued)  y-axis of your graph from 0 to 10 N by double-clicking on the graph, then 

changing the y-axis limits.  The resulting graph should look like that shown in 
Figure 3.  

  

   Figure 3.  Force Score graph format for Activity 1 

 

 

Predictions: •How do you expect the weight of an object measured by the force probe to 
 change as a function of increasing mass? 

 ___________________________________________________________ 
 ___________________________________________________________ 

 •For each of the hanging mass values given in column 1 of Table 1, record 
 your prediction for the weight that will be measured by the force probe in the 
 “Weight” column. 

 
  
 6. Check your predictions.  With no mass initially on the force probe, Start 

graphing.  Wait for 10 seconds, then hang a 100 gram mass with the hanger 
from the force probe hook (make sure you account for the 50 gram mass of 
the hanger in the total mass).  Every 10 seconds thereafter, add 100 grams 
until you have a total of 400 grams. 

 7.  Analyze your data.  From your graph, read the measured force for each 
mass value and record your results in Table 1.  To get the most accurate 
readings, you may want to record the mean values of your data by selecting 
Analyze Data A from the Analyze menu and highlighting (with the mouse) a 
region over which you want your data averaged.  Finally, compute the 
percent difference between the force probe results and your predictions for 
the weights. 
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Hanging  
Mass (kg) 

m  

Predicted 
Weight 

(N) 

Fgravity =mg  

Force Probe 
Reading 

(N) 
% Difference 

0    

0.100    

0.200    

0.300    

0.400    

 Calculate this  Measure this   

     %difference=
measured − predicted

predicted
 
 
  

 
100 %( ) 

Table 1.  Results for Activity 1 

 

Questions: •If you hang a 50 gram mass from a massless string attached to the force 
probe, what value of force would be measured?  What is the tension at both 
the end and middle of the string? 

 ___________________________________________________________ 
 ___________________________________________________________ 

 •Now, if you replace the string with a massless rubber band, then hang the 50 
 gram mass from the band so that it stretches 1 cm, do you predict that the 
 tension in the center of the band will be greater, less than, or equal to that in 
 the previous question? 

 ___________________________________________________________ 
 ___________________________________________________________ 

 •If you are on the moon (gmoon ~ 1/6gearth), what value will the force probe 
 read if you hang a 0.1 kg mass on it?  

 _____________________________________________________________ 
 _____________________________________________________________ 
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Investigation 2:  Newton’s Second Law:  How Force Relates to Motion 
Goal: To study the relationship between force and acceleration. 

 
Activity 2:  A Force For Change 

Introduction: In this activity you will test the relationship between force and 
acceleration,Fnet =ma , under conditions in which the force is not constant. 

Procedure: 1. Prepare to graph net force, F,  acceleration, a,  and the ratio F/a.  
 •  Open... the file FORCE/ACCEL 1 in the Lab 2 folder.  The graphs in 

Figure 4 should appear on the screen. 

    
  Figure 4.  Force/Accel 1 graph format for Activity 2 
 
 2. Set up the motion detector and the force probe. 
  • Place the motion detector on the floor directly beneath the force probe. 
  • Measure and record the masses of a 250 gram hanging mass (including 

hanger) and of the spring provided, for your later analysis. 
      
   
  mhang. mass = __________ [kg]  mspring = __________ [kg]   
  
  • Hang the spring on the force probe, and then hang the 250 gram mass 

on the spring, as shown in Figure 5.  Secure the masses in the hanger 
with tape so they don’t fall and destroy the motion detector (which 
would cost the equivalent of about three or four CD’s!). 
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 motion 
detector
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force 
probe
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  Figure 5.  Experimental setup for Activity 2 
 
 
Procedure: 3. Define the F/a graph.  You will have to redefine the Dist (m) graph in Figure 
(continued)  6 in order to plot the ratio F/a.  To do this, move the mouse pointer over the 

Dist (m) label of the bottom graph on your screen, and hold down the mouse 
button, revealing the menu.  Select the New Column option.  This will give 
you a window which looks like Figure 6 below. 

  

Figure 6.  New Column window for defining a new formula to plot 
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Procedure: 4. You can now define, name, and label the lower graph by clicking in the 
(continued)  appropriate boxes and entering the names shown in Figure 7.  The resulting 

MacMotion graph should look like Figure 8.  Note:  Don’t forget to put the 
quotes “...” around force and accel in the formula field! 

 
 5.  Make sure that you rescale the F/a plot so that the vertical axis goes from 0 

to 1 kg, as shown in Figure 8! 
 

  
Figure 7.  Display for defining the function F/a 

 

Predictions: •Assume that the force probe reads F=0 when the mass is hanging statically 
on the end of the spring.  Using the three graphs provided in Figure 8, sketch 
your predictions for the force on the force probe, the acceleration of the 
hanging mass, and the ratio F/a, when the hanging mass is allowed to oscillate 
over the motion detector.   Be as specific as you can where possible: 

   • What relationship do you expect to observe between the  
  measured force and acceleration? 
 • What value or values do you expect for the ratio F/a, and how do 

you expect the ratio F/a to depend on time?  Write your prediction(s) 
for the value(s) of F/a in Table 2. 

  
Figure 8.  Predictions for Activity 2 
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Procedure: 6.  Zero the probe with the mass and spring suspended from it.  Note: this 
procedure insures that the force probe measures a zero value when the 
hanging mass is in equilibrium, i.e., Fnet = Fspring + Fgrav = 0.  During this 
zeroing process it is important that the mass is stationary. 

  
 7.  Perform the measurement and test your predictions.  
  • Lift the hanging mass about 5 cm and release it, thereby setting it into 

oscillatory motion.  Start graphing. 
  Note:  If your acceleration results look “funny,” i.e., if you see extra 

 peaks or flattened peaks in the acceleration graph, your detector 
 may be either too far or too close to the hanging mass.  Ask your 
 TA to adjust the hanging mass position. 

   
 8. Make a record of your measurement of net force, acceleration, and F/a. 
  • Set Graph Title... to "FMA TANGO" and add your group's names. 
  • Print one copy of this graph.  Note points of significant disagreement 

between your results and predictions. 

 9.  Analyze your data for comparison with your predictions.  Select Analyze 
  Data A from the Analyze menu.  Use the averaging capability of the 

computer to obtain the mean measured values for F/a (try not to include 
“spikes” when averaging your data for mean values).  Record this value in 
the “Measured” column of Table 2 and compute the percent difference from 
your predictions.  

Quantity Predicted 
Value 

Measured 
Value 

% 
Difference 

F/a    

  

Table 2.  Results and predictions for Activity 2

 

Questions: •What quantity is given by the ratio F/a?  If you found a significant difference 
between your measured and predicted values of this quantity, provide possible 
explanations for this difference. 

 ___________________________________________________________ 
 ___________________________________________________________ 

 •Did you find that the acceleration vs. time plot “follows” the force vs. time plot 
in the sense that both force and acceleration increase and decrease at the 
same times, have maximum and minimum values at the same times, etc.?  Did 
you predict this? 

 ___________________________________________________________ 
 ___________________________________________________________ 
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Activity 3:  Push Me-Pull You 
Introduction: If you apply a large enough force on an object--like a cart on a table or an 

uncooperative lab partner--you can get that object to move with an increasing 
velocity, i.e., with an acceleration.  In this investigation you will find that a 
constant net force applied to an object will cause a constant acceleration. 

 You have performed experiments similar to these in Lab 1.  This time the force 
probe is also used and you should focus on the comparison of information 
provided by the force probe with that from the motion detector.  These are 
independent data-gathering tools. 

 
Procedure: 1.  Set up the graph to plot the cart acceleration and the force measured by the 
  force probe as a function of time. 
 • Open... the file FORCE/ACCEL 2 in the Lab 2 folder.  The graphs 

shown in Figure 9 should appear on the screen. 

    

  Figure 9.  Force/Accel 2 graph format for Activity 3 

 

 2.  Attach the force probe to the cart with the Velcro pad, so that the probe is 
oriented with respect to the cart as shown in Figure 10. 

 3.  Use a balance to measure the mass of the cart with the force probe attached, 
and to check the mass of a 100 gram hanging mass (including hanger).  
Record these values below. 

   Cart mass: M = ________ [kg] 

   Hanging mass: m = ________ [kg]  
  
  
 4. Set up the equipment as in Figure 10, making sure that the cart's friction 
  pad doesn’t contact the track at all, and that the string is in the groove of the 

 pulleys.  Also, it’s important that you make sure that the track is level. 
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 motion 
detector

cart

0.5 m← →track

string
 force 
probe

hanging mass  
   Figure 10.  Experimental setup for Activity 3 
 
 
 

Predictions: •Suppose that you hold the cart shown in Figure 10 stationary.  Sketch in 
Figure 11 using a solid line your predictions for the cart’s acceleration and 
the force (i.e., string tension, T) measured by the force probe. 

 •If you now release the stationary cart so that it is allowed to accelerate, will 
the tension measured by the force probe be greater than, equal to, or less 
than that when the cart is stationary?  Sketch in Figure 11 using a dashed 
line your predictions for the cart’s acceleration and the tension measured 
by the force probe in this case.   

  _________________________________________________________ 
  _________________________________________________________ 

 
    Figure 11.  Predictions for Activity 3 
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Predictions: •Verify your first prediction.  Study the free body diagrams for cases A and 
(continued)  B in Figure 12, and make sure you understand the derivation of the 

formulæ given below for both the tension in the string, T, and the 
acceleration of the cart, a, in the (A) stationary and (B) moving cases. 

 
 Figure 12.  Free body diagrams for (A) a stationary system, and for (B) a   

 moving cart + hanging mass system 
 
 Summary: (A).  Stationary System (B). Freely Accelerating System 

  Tension, T: T =  mg 
T = mM

m + M
 g

 

  Acceleration, a: a =  0 
a = m

m + M
 g

 

  •Using the measured values for the mass of the cart and hanging mass, use 
the equations above to predict values for the cart acceleration and the 
tension measured by the force probe for both (A) stationary and (B) moving 
cases shown above.  Record your predictions in Table 3. 

 

Cart T 
(Predicted) 

[N] 

T 
(Measured) 

[N] 

% 
Difference

a 
(Predicted)

[m/s2] 

a 
(Measured)

[m/s2] 

% 
Difference

Stationary           ------- 

Moving       

   Table 3.  Results and predictions for Activity 4 
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Procedure: 5. Test your predictions by making a measurement of acceleration and force. 
(continued) 
  •  Remove any mass hanging at the end of the string shown in Fig. 10. 
  •  Zero the force probe (with no mass on the string). 
  • Clear any previous graphs (Clear Data A and Clear Data B). 
  • Hang a 100 gram mass over the pulley. 
  • Start graphing.  At t = 3 seconds, release the cart.  Be sure the motion 

detector "sees" the cart the whole way down the track.  You may need 
to guide the probe’s cable so that it doesn’t hinder the cart’s motion. 

  • Repeat until you get good graphs. 

 6. To better see your results, rescale the y-axis of the force versus time plot so 
that it ranges from 0 to 2 N.  Do this by double-clicking on the force graph 
and changing the y-axis minimum and maximum values. 

 7.  Make a labeled record of your experiment. 
  • Set Graph Title... to "NON-ZERO ACCELERATION" with names. 
  • Print one copy.  On the printout, indicate where you released the cart. 

 8.  Analyze your data for comparison with your predictions.  Select Analyze 
   Data A from the Analyze menu.  Determine the mean measured values 

 for tension and acceleration for both (A) stationary and (B) accelerating 
 cases.  Record these averages in Table 3 and compute the percent 
 difference from your predictions if the values are nonzero.  

   

%difference = 100 * measured - predicted
predicted

          

Questions: •Does the tension in the string change when you allow the cart + mass system 
to accelerate?  Did you predict this? 

 ___________________________________________________________ 
 ___________________________________________________________ 

 •Did your predictions for the cart’s acceleration when moving agree well with 
your measurements?  If not, what are the possible sources of error? 

 ___________________________________________________________ 
 ___________________________________________________________ 

 •In the case of the moving system, if you doubled the mass of the cart, by what 
amount do you predict the acceleration of the cart would change compared to 
that measured above?  Explain. 

 ___________________________________________________________ 
 ___________________________________________________________ 
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Investigation 3:  Hooke’s Law and the Spring Force 
Goals: To study Hooke’s force law for a spring, and to determine the force constant of a 

spring. 

Activity 4:  It’s Spring Time in Urbana 
Introduction: Tension, weight, and the normal force are examples of passive forces, i.e., 

forces which are not explicit functions of position or velocity.  By contrast, some 
forces with which you are familiar do depend on position or velocity.  For 
example, when stretched or compressed, a spring exerts a tension or 
compression force on an object attached to the spring.  Over a limited range of 
extension or compression, it turns out (as you will see) that the force exerted by 
the spring is directly proportional to the extension or compression distance.  
Over this range, the spring is said to obey Hooke’s Law, Fsp = -kx, where x is the 
amount of extension or compression, and k is the spring constant.  In this 
activity you will verify Hooke’s law for a spring and measure the associated 
spring constant, k. 

 
 

Procedure: 1. Configure the MacMotion graphs. 
 •  Open... the file SPRING in the Lab 2 folder.  A graph like that shown in 

Figure 13 should appear on the screen. 
 

    
    Figure 13.  Spring graph format for Activity 4 
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Figure 14.  Experimental setup for Activity 4 

 
Procedure: 2. Set up the track, cart, motion detector, and force probe as shown in 
(continued)  Figure 14. 
  • Exchange the cart with the large card taped on the back (used in 

Activity 3) with the plain, “cardless” cart provided. 
  • Using the Velcro pad, attach the force probe onto the cart in the 

orientation shown in Figure 14. 
  • Hook the hanging mass to the small smooth knob on one end of the      

 cart. 
  • Hook the spring provided between the force probe and the post 

 mounted on the side of the track using the available string. 

 3.  Measure the stretching of the spring provided for several different forces:  
  • Zero the force probe with the spring attached, but with no hanging    

 weight. 
  • Carefully  measure the position of the spring for each of the four 

 hanging masses listed in Table 4 below.  Make sure that the mass on 
 the spring is completely stationary before making a measurement.  
 You can obtain very accurate readings of both spring position and 
 force by: 

    •• Plotting a distance vs. time graph to obtain the spring extension. 
    •• Plotting a force vs. time graph to obtain the spring force. 
  • Record your force and spring position results in Table 4.  Use mean  

 values for these quantities, obtained by choosing Analyze Data A, 
 then highlighting the flat regions of the force and distance plots and 
 reading the mean values under Statistics. 
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Hanging 

Mass [kg] 
m  

Force [N] 
F 

Cart Position [m] 
x  

0.150   

0.200   

0.250   

0.300   

  Table 4.  Spring force and cart position for Activity 4 
 
Procedure: 4. Analyze your data.  Plot the measured spring force, F, as a function of the 
(continued)  measured cart position, x. 
  • Open the file called DATA ENTRY 2  in the Lab 2 folder. 
  • Select Data A Table under the Windows menu.  You should see a new 

window labeled "Data A" similar to that shown in Figure 15. Enter 
numerical data directly into the table in the spaces shown. 

   
 Figure 15.  Table for entering the spring force and cart position for Activity 4 
 
  • Record your spring force and position values in the two columns in the 

on-screen table (see Figure 15). 
  • When all your data has been entered, click once on the graph window to 

bring it to the front and view your points. 
  • Double-click on the graph window and adjust the scale so that your 

points are visible.  Rescale so that there is not a lot of blank space. 

Questions: •Does your data exhibit the linear relationship between the spring force and 
 spring displacement described by Hooke’s law, F = -kx?  If it appears to you 
 that your results don’t get the right “sign” on this force law, you might want to 
 read Appendix A on the last page of Lab 2. 

 ___________________________________________________________ 
 ___________________________________________________________ 
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Procedure: 5. Determine the spring constant, k, of the spring by “fitting” your data 
(continued) 
  • Select Fit... under the Analyze menu.  A window like that in Figure 16 

will appear in which you specify the kind of mathematical formula to try. 

 

 Figure 16.  Window for defining the fitting function for Activity 4 

  • Make sure that Linear is selected (since you expect a linear relationship 
between F and x), and then click on Maintain Fit.  You should now see 
a straight line on top of your graph, which is the computer’s "best fit" 
through all the data points.  If it doesn't look right, ask your TA. 

  • Re-adjust your display scale if necessary to better view the points. 
    
 Below, record the slope of the “best fit” through your data. 

 
b1 = ________ 
 

 6. What is the relationship between this “best fit” slope through your data, b1, 
and the spring constant, k? 

 
    __________________________________________________ 
   7. Use this relationship, as well as the fitted slope through your data, to obtain 

and record a measured value for k (include units). 
 
      k = ______________ 
    
 8. Make a record of this fit to your data. 
  • Set Graph Title... to "HOOKE’S LAW" and append your group's names. 
  • Print one copy of this graph. 

  

• Record your measured spring constant, k, on the plot.
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Appendix A 

Sign Problem?   You may be surprised by the fact that as you increased the size of the 
hanging mass, m, and consequently the size of the spring extension, ∆x, 
your MacMotion graph recorded an increased positive value for the force 
as a function of increasing ∆x!  Is this measured positive value in 
contradiction to Hooke’s law, which predicts a relationship between the 
spring force and spring extension given by Fspring = - k ∆x?  The answer 
is no!  To clear up any apparent contradiction, first study Figure 17 and 
notice that as you increase the size of the hanging mass, the spring 
force will tend to pull on the force probe “hook.”  Now, recall from Activity 
1 that a “pull” on the force probe is by default recorded on the 
MacMotion graph as a positive force, thus the positive force value you 
observe in this activity.  Is this in contradition to Hooke’s Law?  No!  
Hooke’s Law tells us that the spring force is always in the opposite 
direction to the extension or compression of the spring, Fspring = - k ∆x.  
Since increasing the hanging mass extends the spring by an amount ∆x 
in the direction shown in Figure 17, Hooke’s law tells us that the spring 
force, Fspring, will act in the direction opposite the spring extension, ∆x, 
i.e., will “pull” on the force probe hook as shown in Figure 17, in 
agreement with your observation (hopefully!).  If this point is still 
confusing to you, ask your TA for help. 

  

T

∆x

Fspring

T

mg

m

force 
probe

hanging 
  mass

spring

 
Figure 17.  Directions of forces present in Activity 4 

 


